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Welcome

What is the R50 used for?
The Filmetrics R50 is used to measure the sheet resistance of conductive and semi-conductive films using
either a contact (4PP) or non-contact (EC)method. The standard automated X-Y stage allows for easy
mapping of sample surfaces and can makemeasurements as quickly as one point per second. Samples
up to 300mm in size can bemeasured, over an area up to 200mm (-200model required for larger
samples).

Commonly measured films include various semiconductor substratematerials such as wafers, glass, and
plastic substrates, as well as PCB patterned features, solar cells, flat panel display layers and features,
and metal foils.

Warning:Accurate measurements require suitable recipe settings. Improper system setup may lead to errors. It is
the user’s responsibility to ensure this instrument is being used properly andfor its intended purpose. Please
contact Filmetrics support for assistance with any questions.
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Safety, Maintenance, and Care

This symbol indicates information or instructions that must be read and carefully followed to prevent
hazards, injury to the operator, or damage to the instrument.
Ce symbole indique des informations ou des instructions qui doivent être lues et suivies attentivement
pour éviter les dangers, les blessures de l'opérateur ou les dommages à l'instrument.

This symbol indicates a potential shock hazard. Areas marked with this symbol should be serviced by a
trained service technician.
Ce symbole indique un risque d'électrocution. Les zones marquées de ce symbole doivent être réparées
par un technicien demaintenance qualifié.

This symbol indicates that the product conforms to theWEEE (Waste in Electrical and Electronic
Equipment) Directive 2002/96/EC. For further details contact:
Ce symbole indique que le produit est conforme à la directive DEEE (Déchets dans les équipements
électriques et électroniques) 2002/96 / CE. Pour plus de détails, contactez:

Filmetrics Europe GmbH
Hauptstr. 42
82008 Unterhaching
Germany
+49 89 22061245

This symbol indicates that the product meets the applicable EU safety, health and environmental
protection directive requirements.
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Ce symbole indique que le produit est conforme aux exigences de la directive européenne en vigueur sur
la sécurité, la santé et la protection de l'environnement.

This label indicates theModel Number and Serial Number of the instrument. This information may be
necessary when contacting Filmetrics for assistance.
Cette étiquette indique le numéro demodèle et le numéro de série de l'instrument. Ces informations
peuvent être nécessaires lorsque vous contactez Filmetrics pour obtenir de l'aide.

Disclaimer: Use of this instrument in a manner inconsistent with the information and directions included
in this manual may impair the product's built-in protection resulting in danger to the operator or damage
to the instrument.
Clause de non-responsabilité: L'utilisation de cet instrument d'unemanière non conforme aux
informations et aux instructions incluses dans cemanuel peut altérer la protection intégrée du produit,
ce qui peut entraîner un danger pour l'opérateur ou endommager l'instrument.

Disclaimer: Protective Personal Euipment (PPE) provided with this tool must be used in accordance with
the instructions provided by the supplier. Failure to do so may result in danger to the operator.
Clause de non-responsabilité: l'équipement de protection individuelle (EPI) fourni avec cet outil doit être
utilisé conformément aux instructions fournies par le fournisseur. Le non-respect de cette consigne peut
entraîner un danger pour l'opérateur.

Installation Location: Install the instrument in a well-ventilated location. Enclosing the unit or blocking
the vent holes may impair the performance of the instrument or damage the internal components.
Emplacement d'installation: installez l'instrument dans un endroit bien ventilé. Le fait de fermer
l'appareil ou de bloquer les orifices d'aération peut nuire aux performances de l'instrument ou
endommager les composants internes.
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Cleaning: Periodically clean the system based on the cleanliness of the environment in which the system
is installed. Only the external surfaces should be cleaned. Cleaning and maintenance of all internal
components is to be performed by a trained service technician. Do not use aerosol or spray cleaners as
they may contaminate the sensitive optical surfaces on the instrument.
Nettoyage: nettoyez périodiquement le système en fonction de la propreté de l'environnement dans
lequel le système est installé. Seules les surfaces externes doivent être nettoyées. Le nettoyage et la
maintenance de tous les composants internes doivent être effectués par un technicien demaintenance
qualifié. N'utilisez pas de nettoyants en aérosol ou en aérosol car ils peuvent contaminer les surfaces
optiques sensibles de l'instrument.

Disconnect themain power before performing any service on the instrument.
Débranchez l'alimentation principale avant d'effectuer tout entretien sur l'instrument.

Cleanroom or low lint wipes should be used to wipe down the system. Amixture of Isopropyl Alcohol
(IPA) and De-ionized Water (DI H2O) at 70%DI H2O: 30% IPA should be used for cleaning. Undiluted IPA
may be used, if the 70:30 DI and IPAmixture is not available, but extra caremust be taken. Avoid using
stronger solvents such as acetone, as thesemay compromise the surface finish.

Avoid excessive pressure on any surface when cleaning. Excessive forcemay bend a component which
would damage the system or cause the system to be out of alignment.

When cleaning, start with the top of the system and work down. Use slowmotions, in a straight line,
from the back to the front of the surface being cleaned. Change the cleaning wipe periodically to avoid re-
depositing material back onto the surface being cleaned. Allow all cleaned surfaces to dry completely
before restoring power to the system.

Une salle blanche ou des lingettes peu pelucheuses doivent être utilisées pour essuyer le système. Un
mélange d'alcool isopropylique (IPA) et d'eau désionisée (DI H2O) à 70%DI H2O: 30% IPA doit être utilisé
pour le nettoyage. L'IPA non dilué peut être utilisé si le mélange 70:30 DI et IPA n'est pas disponible, mais
des précautions supplémentaires doivent être prises. Évitez d'utiliser des solvants plus puissants tels que
l'acétone, car ils peuvent compromettre la finition de la surface.

Évitez toute pression excessive sur toute surface lors du nettoyage. Une force excessive peut plier un
composant, ce qui endommagerait le système ou provoquerait un désalignement du système.

Lors du nettoyage, commencez par le haut du système et descendez. Utilisez des mouvements lents, en
ligne droite, de l'arrière vers l'avant de la surface à nettoyer. Changez périodiquement la lingette de
nettoyage pour éviter de re-déposer le matériau sur la surface à nettoyer. Laissez sécher complètement
toutes les surfaces nettoyées avant de remettre le système sous tension.
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CE Mandated Warnings

Please read the following instructions carefully to prevent potential shock or fire hazards. This manual
should be retained for future use

Bitte lesen Sie die nachstehende Anleitung sorgfältig durch, um Stromschlag und Feuergefahr zu
vermeiden. Diese Betriebsanleitung soll für späteren Gebrauch sorgfältig aufbewahrt werden.

Preghiamo di leggere accuratamente, le sequenti Instruzioni, per evitare Prossiomi Incendi e Correnti.

Shock Hazard - Do Not Enter
Achtung Hochspannung - Nicht Berühren

Attenzione Corrent-Forte - Prego non toccare

The power cord should be removed after use.
Das Stromkabel soll nach Gebrauch aus dem Gerät herausgezogen werden.

La Corrente viene.

Never expose the unit to water or liquids. Avoid direct sun.
Bringe das Gerät nicht mit Wasser oder anderen Flüssigkeiten in Berührung. Vermeide direkte

Sonneneinstrahlung.
Evitare contatto con acqua oppure liquidi Infiammabili al Macchineggio. Auche entrate di Sole.

Do not insert any objects into the unit.
Keinen Gegenstand in das Gerät einbringen. Do non inseriamo any obietta into gli unità.

Non mettere ogetti dentro la Macchina.
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Do not use near open flame or heat.
Das Gerät nicht in der Nähe einer offenen Flamme oder Hitze benutzen.

Non mettere la Macchina vicino a fuochi oppure Riscaldamenti.

The unit should never be enclosed or blocked.
Das Gerät darf nicht eingeschlossen oder blockiert werden.

La Macchina non chinderla per nessun motivo.

Connect unit only to a properly measured supply with a reliable earth ground. Use only the which is
provided with the unit.

Schließen Sie das Gerät nur an eine ordnungsgemäss vermessene Stromsversorgung an. Verwenden Sie
nur ein , wie es auch mit dem Gerät ausgeliefert wird.

Montare solo con misura normata. Adoperando solo cosi come e fornita la
Macchina.
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1. Software Overview
Sheet resistance is the resistance of a square sheet ofmaterial of arbitrary size. It is designated as Rs, and
measured in units of Ohm/sq. The R50 is measures sheet resistance of a sample directly, either by four-
point probe (R50-4PP, R50-200-4PP), or by eddy current (R50-EC, R50-200-EC).

For four-point probe systems, this analysis is made by bringing the probe in contact with the sample and
measuring the voltage drop between a current supplied from the outer pins.

For eddy current systems, this analysis is made by measuring the induced eddy currents from the
sample surface when a time varying current is passed through a probe coil.

Most of the features of the R50 operation software - RsMapper - can be divided into data acquisition and
data analysis functions. The following pages outline themain features of the RsMapper software.
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1.1 The Wafer Map Tab

1. Standard menus: File, Edit, Setup, Acquire, and Help.

2. Select between theWafer Map,Measure, and Historywindows.

3. Information about theOperator can be entered here for tracking purposes.

4. This section is used to determine how themap is displayed. The Replot button will enact any changes
selected.

i. Parameters to Display: Allows the user to select which parameter (Rs, Ra/Rb, Ra, Rb) to display on
themap. Only parameters currently being solved will be listed.
ii. 2D/3D: Allows the user to select between two-dimensional and three-dimensional maps.
iii. Show Color: Enables or disables the color bar on the left-hand side of themap.
iv. Show Points: Enables or disables display of themeasured points on themap.
v. Show Values: Enables or disables display of themeasured values at each point.
vi.Manual Color: Allows the user to input a manually selected color scale.

5. Statistical analysis for the set ofmeasurements taken.
i.Minimum parameter value recorded for selected wafer, xmin.
ii.Maximum parameter value recorded for selected wafer, xmax.
iii.Mean (average) parameter value of all measurement locations.

iv. Std.Dev. (Standard Deviation), or 1σ, is calculated using the following equation:
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where is themean and n is the number ofmeasurements.
v. Uniformity as a percentage. The equation used in the uniformity calculation is determined under
Setup > Options > Map.
vi. CTE is the center-to-edge thickness variation calculated using a least squares linear fit of the
average thickness of 10 radial regions. If the CTE is positive (> 0), then the thickness is greater
around the wafer edge. If the CTE is negative (< 0), then the thickness is greater near the center of
the wafer.
vii. TheWedge value is the product of the slope at the angle specified by theWedge Angle and the
sample diameter (for rectangular samples the length of the longest edge is used in place of
diameter).
viii. The direction ofmaximum positive slope (increasing measured values) is given by theWedge
Anglewhere x=1, y=0 is 0° (3 o’clock) and x=0, y=1 is 90° (12 o’clock).
ix. Valid indicates howmany locations have valid results out of the total number ofmeasurement
locations based on theminimum valid GOF set under Alarms in the recipe.

6. These options control the wafer map process.
i. Start or Restart themapping cycle. Not available if there is no valid baseline or a map in progress.
ii. Stop themapping cycle.
iii. New clears themeasurement results and displays the points to bemeasured as determined by
the settings in Edit Recipe > Wafer Map tab.
iv. Go To a specified location on the wafer.
v. Reanalyze the current map if the recipe has been changed or a new recipe has been selected.
vi. Probe Qual
vii. Select previously saved recipes from the drop-down menu.
viii. Opens the Edit Recipewindow.

7. Graphical display of the wafer with points ofmeasurement as well as a color scale for thickness
summary.

Based upon the options selected, left clicking on a point will either move the stage to that exact location
or the nearest point on themap. Right clicking opens the following menu, which allows you to either
mark a currently measured point as invalid, remeasure an individual invalid point using the current
recipe, or interpolate the value of an invalid point using adjacent values.
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1.2 Measure Tab

1. Standard menus: File, Edit, Setup, Acquire, and Help.

2. Click on these tabs to select between theWafer Map,Measure, and Historywindows.

3. Controls themotion of the stage and the probe head.
i. Probe Up lifts the probe away from the stage.
ii. Go To provides motion controls for the stage and measurement head.
iii. Probe Down brings the probe down into measurement position.
iv. Go To Z Measure brings the probe to a preset height for measuring the sample. Set this value via

Z Height Measure Calibration.
v. Probe Changemoves the head up to allow easier access for changing out the connected probe.

4.Measurement Controls. Available controls will be dependent on themeasurement mode available
(4PP or EC). SeeMaking Measurements for further information.

5. Select an existing recipe by clicking on the drop-down menu, or open the Edit Recipe dialog for the
current recipe.
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6. Results are displayed here.

7. For EC measurements, the liftoff curves are displayed here.
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1.3 Go To

TheGo To function allows the user to manually locate the system in the x, y directions, and with capable
systems, the z direction. Measurements may be entered as discrete coordinates or by clicking on the
arrow keys to move the stage accordingly. When using the arrow controls, the single arrows allow a
slower movement speed while the double arrows are for faster motion.

1.4 History Tab
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1. Standard menus: File, Edit, Setup, Acquire, and Help.

2. Click on these tabs to select between theWafer Map,Measure, and Historywindows.

3. Used to alternate between the Single Measurement andMeasurement Trend tab. Selecting the
Measurement Trend tab will allow the user to see a plot of themeasurement results versus
measurement number. A drop-down list allows the user to select between which parameter is displayed.

When the Measurement Trend tab is selected in the Historywindow, the right side of the screens graphs the
results.

4. Shows the results for the selected measurement (must be in Single Measurementmode).

5. Displays the liftoff curve for -EC tools in Single Measurementmode, or themeasurement trend plot in
Measurement Trendmode.

6. Displays statistics for all measurements included in the history file. This data can be selected for
copying and pasting outside of the software.

7. This list contains all results currently included in the history file. Left-click on a column header to re-sort
the data in ascending or descending order based on the selected column. Right-click anywhere in this box
to allow the user to open the Edit Columns control panel.
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1.5 Edit Recipe Window

The Edit Recipewindow is used to define the wafer map and to set acquisition parameters. More
information on how to configure the recipe is included in the Editing Film Recipes section.

1. These buttons allow the user to (in order from left to right):
i. Open a saved recipe.
ii. Start a new recipe.
iii. Save the current settings.
iv. Save the current settings as a new recipe.
v. Delete the current recipe.

2. Opens a drop-down list for quick access to saved recipes.

3. Select or add additional Sites to your measurement.

4. Author, defined by user login name and recipemodification date, is indicated here.

5. Allows the user to select between theWafer Map and Rs Acquisition Settings tabs.
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6. This is where the various parameters are defined, further explained inMaking Measurements.
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1.6 Menu Controls

This section describes the various functions available through the standard menus.

File Menu

Edit Menu

Setup Menu

Acquire Menu

Help Menu

1.6.1 File Menu

Open History…
Load previously saved History data containing measurements and statistics.

Open Wafer Map… (Wafer Map Tab only)
Open stored wafer maps, which are then displayed and can be analyzed for sheet resistance.

Open Difference Map… (Wafer Map Tab only)
Display resistance differences between two maps (Map2-Map1). Film structure and map pattern must be
the same for both map recipes. Press the Select Map button to browse for themap files.

Import: Recipe…
Import recipes that were previously exported or created with an older version of RsMapper.
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Import: Material…
Import materials not currently in the software either, created by the user or provided by Filmetrics.

Import: License…
When the user purchases an upgrade for the system, Filmetrics will send a license file to the user. The
licensemust be imported into the software before upgrades are effective.

Save Screen to File… (Measure Tab only)
Take a screenshot of the RsMapper window.

Save Wafer Map… (Wafer Map Tab only)
Savemeasured wafer maps for export or later analysis. Files can be saved in two different formats:

*.fiwmc: This file is the preferred way to savemaps. This file will contain all data captured in
measurement process.

*.fimap: This file can be opened in all versions of RsMapper.

Export: Recipe…
Recipes can be exported for use on other computers running RsMapper. The exported file automatically
includes any material files required by the recipe. Duplicate an analysis on any other computer running
RsMapper using the exported recipe and the spectrum being analyzed.

Export: SystemInfo File…
For certain software upgrades the user is required to send the SystemInfo file to Filmetrics which can be
exported using this command.

1.6.2 Edit Menu

This menu allows access to theMap Pattern editor.



20

Map Pattern…(Wafer Map tab only)

The Edit Map Pattern dialog is used to specify themeasurement pattern on the wafer. Patterns can be
generated automatically through the dialog, or pre-existing patterns can be opened or imported for
review.

When generating patterns automatically, first determine if the wafer shape is round or rectangular under
theWafer Type option. The pattern type specifies the pattern geometry within the wafer shape. If Round
is selected, enter the expected wafer diameter into the Round Info text box at the bottom of the dialog
window. If Rectangular is selected, the Rectangle Info allows the input of both height and width data of
the sample. All measurements are assumed to be in millimeters. RsMapper will automatically scale the
wafer map to match other wafer sizes if a different wafer size is input during recipe creation in the Edit
Recipe > Wafer Map dialog.
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The pattern density and central exclusion features specify the exact distribution of themeasurement
points on the wafer. A greater density leads to an increased number ofmeasurement spots and can only
be increased in whole numbers. Central Exclusion can be used to set an exclusion zone in the center of
the wafer where no points are placed. The exclusion must be <1 in order to function properly. The Radial
Pattern Details options are only enabled when the type is set to Radial. Enabling theManual Spots per
Quadrant option will allow for further modification of the number ofmeasurement spots even further by
increasing the number of spots per each concentric ring.

Rectangular patterns are used to modify spot density, and with the additional Fixed option allow the
manual entry of the number of spots per each row and column.

Linear patterns, by default, are set to measure from Center to Edge, but can be set to Edge to Edge using
the Linear Pattern Details options.

Display an updated version of themap pattern by clicking Redraw after changing any of the above
values. Save as will save the newmap pattern in theRsMapper\Patterns\Custom folder under a user-
determined name.

If the x-y coordinates for a specific pattern are known, RsMapper software will recognize a text file of
these coordinates. See Editing Map Files Using Excel for more details on creating custom maps.

All custom patterns must be saved in RsMapper\Patterns\Custom folder. To select the new pattern in the
Edit Recipe > Wafer Map tab, select the Custom Coordinate System and the name of the pattern from
the drop-down box.

1.6.3 Setup Menu

This menu contains the settings for Display options and the Raw Signal dialog. This is also where user
access can be set through the Access Control option, as well as modifying some system Options.

Access Control
RsMapper incorporates password protection to limit access to themeasurement software and settings.
When the software is initially installed, access control is turned off. The software automatically starts with
Engineer level access that enables access to all features of the program except turning on and off access
control and adding and deleting users.
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Turning on access control requires Supervisor level access. The software is delivered with one user, a
supervisor, in the list of authorized users as shown below:

UserID: filmsuper

Password: filmetricsfff

To turn on access control, log in as filmsuper using the password shown above. Select the Activate
Access Control checkbox to enable access control functions. User ID and Password are case-sensitive.

To add an operator level user, select operator from the Access Level list box, type a username and an
initial password, and then click the Add User button. To add an engineer or a supervisor user, use the
same procedure as above, then select the appropriate access level from the list box before clicking the
Add User button.

To delete a user, enter theUserID and press theDelete User button.

Operator and Engineer level users passwords can be changed while logged in by entering the password
into the password box and pressing the change button. Supervisor-level user passwords, or the
password of any other user, can be changed by selecting the appropriate access level, entering the
appropriateUserID and new password, then pressing Add User. If the software finds that a user already
exists, the old entry for that user will be deleted and a new entry created.

We recommend creating a new supervisor level user, then deleting the filmsuper user for maximum
security. If all supervisor level users forget their passwords, it will be necessary to re-install the software
and add all the users again.

Options
TheOptionsmenu allows the user to enable, disable, or modify several different settings within
RsMapper.

General Settings
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Data Recording

Calibration

General Settings

TheGeneral Settings tab is used to enable, disable, and modify various options in the software.
Hide or show themenu bar when using Save Screen
to File.
Enable or disable whether the software displays a
warning before clearing all spectra on the screen
when the Clear Graph button is pressed.
Enable or disable automatically increasing the
number of spectra displayed on the graph when
opening multiple saved spectra.

You can also set whether to show a confirmation
message before increasing the number of spectra.
Toggle whether the software prints out all currently
loaded spectra, or only the active curve when using
the Print feature.

Enable or disable whether the warning dialog before
you delete entries in the history file.

Open a dialog that allows you to control which
columns are visible in theHistory tab.

Enable or disable the baseline reminder feature, and
if enabled to set the reminder interval.

Set your Reflectance Standard Signal Threshold val-
ues. These determine at what percentage of the ini-
tial signal intensity the software will display a
warning during the process. This feature is used to
track lamp health, proper baseline procedure, and
other parameters.
Enable or disable theUniform Spectra Data Point
Spacing function. When enabled, saved spectra will
have their values set to a multiple of 1, 2 or 5. Stand-
ard Spacing sets the spacing equal or greater than
the smallest interval in the data, while Fine Spacing
sets the spacing to shorter than the smallest inter-
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val.
For systems with multiple user accounts, enable or
disable sharing settings across all users. A folder to
store the settings file may be selected.
For systems with multiple user accounts, enable or
disable sharing settings across any users who have
slected this option. A folder to store the settings file
may be selected. This option is only available if Share
Settings with all users isn't enabled.
This feature allows the user to select a different
location for their Recipes folder, for example to a
shared network drive. This can be useful for syncing
recipes across multiple instruments in varying
locations.

Selecting Resetwill instruct the software to look in
the default location for the Recipe folder.
This feature is similar to the one above, only it allows
you to choose a different location for yourMaterials
folder.
Enable or disable whether the software prompts you
when it is ok to disconnect the instrument at soft-
ware shutdown.

Click to restore all settings to their default values.

Calibrate Z Measure Height.
This dialog sets the position for theGo To Z Measure Height button to insure rapid measurements and
that the probe doesn't crash into the sample. This value is set in two ways; an automated calibration or
by manual entry.
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If the appropriate z-height is already known, enter that value into theNew value: text box underManual
Input and then click Update.

To have RsMapper automatically determine the appropriate height, first use theGo To command to
raise themeasurement head at least twenty mm above the sample surface before launching the Z-Height
Measurement Calibration via the Setup > Options > Wafer Mapmenu.

With the head positioned an adequate distance above the sample, click Start to begin the calibration.
The head will step down to find the sample, updating theNew value and Current value fields when
complete. Click Close to exit the calibration. After calibration, clicking Go to Z Measuremoves the head
to the calibrated height in preparation for measurement.

Data Recording
TheData Recording tab contains controls for the various methods by which RsMapper may
automatically save collected data.

Enabling Automatically append results to filewill
instruct the software to create an excel file at a spe-
cified location in which a running tally ofmeasured
results are kept.

This feature is different from theHistory tab in that it only records results, not the spectra files as well. It
does not however have an upper limit on the number of spectra that can be recorded.

Enabling Save once per spectrum will only append results when theMeasure button is pressed or a
saved spectra is opened in the software. Any changes in the recipe applied to existing spectra will not be
recorded. When this feature is disabled, any time a spectra is analyzed the result is entered into the file.
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When Confirm before saving is turned on, the software will
provide a prompt before appending data to the excel file.

Continuous Measure: Measurement History Inclu-
sion controls which spectra are included in theHis-
tory tab when the Acquire > Measure Continuously
feature is used.

If the software is set to Prompt user to select History inclusion mode, a dialog will pop up prior to
beginning the continuous measure asking the user whether to save all measurements while measuring
continuously, or only the last measurement. The only last measurement feature can be useful on less
ideal surfaces (rough, non-uniform, etc.) where the user may have to search around the sample surface
for a spectrum capable of being analyzed.

Clicking Don't ask me this againwill disable the prompt, and the user will have to navigate back to this
menu to re-enable the feature.

The user can also select between having the software provide a prompt for which data to include in the
history file when using Acquire > Continuous Measure or to record all measurements to theHistory tab.

The Automatically archive History feature can be
used to have the software save a copy of the history
file whenever it hits 1000measurements.

The history files are saved in the following format (YYYY-MM-DD-X) where YYYY is the year, MM is the
month, DD is the day, and X is a serialized number based on howmany history files have been saved on
a given day.

A value can be entered in megabytes for themaximum disk space to be allocated for the saved archives.
This will keep the software from using up all available hard disk space if the feature is enabled and then
forgotten. Should the software hit the allocated max, it will delete the oldest files in the selected folder
until enough space is available for the new history file.
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Clicking Clear History after archive is writtenwill instruct the software to automatically clear the history
results after 1000measurements have been reached, and then begin counting towards the next group.
When it is disabled the history feature will work in the normal mode upon reaching 1000measurements
(newest measurement is added as Meas #1000, Meas #1 is deleted). It will write the next history file upon
reaching 1000measurements again, not each time theMeas# counter shows 1000.

1.6.4 Help Menu

Help > About RsMapper
Information about the hardware and software versions and the system serial number can be found here.
Please have this information available when calling Filmetrics for technical assistance.

Help>About RsMapper... window
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2. Editing Film Recipes
Recipes are used to configure the film stack, measurement map, and acquisition settings for the system.
If varying samples or processes are being measured, multiple recipes can be saved to quickly switch
settings as appropriate.

The Edit Recipe dialog box is accessed with the Edit Recipe... button on theMeasure Tab, or the Edit…
button on theWafer Map Tab.

2.1 Adding, Changing, or Deleting a Structure

When the Edit Recipe dialog box is opened, it shows the stored specifications of the structure selected
from the Recipe Name: list, along with any changes made since the recipe was loaded. Changes to the
selected structure can be permanently stored by making the desired changes and clicking Save. Changes
can also be stored as a new recipe by clicking Save As. A structuremay be deleted (removed from the
Recipe Name: list) by clicking theDelete button. Recipes can bemoved between computers using the
File > Import > Recipe and File > Export > Recipe commands.
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2.2 Wafer Map

This wafer map tab allows various settings to be specified in relation to how themap is generated. This
includes the size and type of wafer to be analyzed, the configuration of themeasurement spots, as well
as data saving protocols.

2.2.1 Measurement Configuration
Wafer Diameter: Diameter of wafer to bemeasured – choose from the list. When using rectangular
patterns, this option will switch toWidth and Height, with text boxes to enter the appropriate values.

Coordinate System: Polar, Rectangular, Linear, or Custom.

Number of Points or Custom Name: Number of points to bemeasured or select the name of the
custom pattern file.

Edge Exclusion: Distance from outermost points to the edge of the wafer.
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Advanced Settings: When using a rectangular map, the advanced rectangular map settings option is
enabled for use. This menu allows the user to define the sample origin point in one of five locations; top-
left, top-right, center, bottom-left, or bottom-right. Automatic Alignment can be used to help find the
edges of the sample.

Rotation Angle: Sets a fixed angular offset to all measurements in themap. 

2.2.2 Offset Map Origin
This feature is intended to allow the origin point location used for themeasurement map to be specified.
If no option is selected, the software defaults to centering all maps around the (0,0)measurement
location. Once selected there are two options available:

1. Relative to Start Location -When the Start button is clicked, the software uses the current (x,y)
position as the origin for themap. This position is not saved as part of the recipe.
2. Absolute - Set a specific (x,y) location as the origin of themap.

2.2.3 Automatic Data Saving
If a filename is entered in the upper right corner of theWafer Map View>Map Information field, a new
folder with that namewill appear in theRsMapper\MapResults folder. If no name is specified, all saved
data will appear in theMapResults folder.

Save Results to Disk: Automatically saves themap after completion ofmeasurement. Depending on the
settings in Setup>Options>Wafer Map, maps are saved as an .fimap or .fiwmc file.

2.3 Acquisition Settings
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Control Current Selection, Partial Lift, Temperature correction, enable Auto Re-probe, select the
measurement Method, select the 4PP Mode used or which Liftoff curve to analyze when using eddy
current, and open the Edit Derived Parameters dialog.

Current Selection
Toggle through the different radio buttons to select how the current is generated for testing.

NOTE: These features are still in development. Descriptions and functionality may change in future
software releases.

Auto Range: Allows the software to find the best current range when measuring the sample. Select a
starting current in nA, μA, or mA, as well as a target voltage in mV.

Fixed: Set a fixed current in nA, μA, or mA.

Optimize Current: Allow the software to select the best current range based on data from the sample.
Click Enable to set the values.

Partial Lift
When enabled, this feature shortens the lift distance of the probe head during themapping procedure as
a percentage of total lift height. This allows for quicker measurements on the R50.

Note it is recommended to test theminimum Life percentage required in single measurement mode to
insure clearance with the sample surface beforemapping. Failure to provide enough lift may result in
damage to the sample, probe or both.

Temperature Correction
The temperature correction option allows for adjusting measurement results based on the temperature
of the sample. To set the correction factor, select thematerial to bemeasured from the drop-down
menu. The TCR value populates automatically. Next, enter the temperature the sample should be
corrected to in the text box. Click OK to exit the dialog. The correction will be applied to future
measurements.
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Auto Re-Probe
When enabled, if there is a measurement failure at a given location a short series ofmeasurements will
be taken in nearby locations to attempt to complete a good measurement. Limits can be set as a
function of sigma of standard deviation high and low, as well as the number ofmeasurement retries that
should be attempted.

Method
For systems with both the four-point probe and an eddy current detector, use the drop-down menu to
select which probe is currently in use.

Liftoff
NOTE: This feature is still in development. Descriptions and functionality may change in future
software releases.

Select where in themotion of the eddy current probe the liftoff curve is measured when making a full
measurement. Select Drop to measure on the down motion, and Lift to measure on the upward motion.

Edit Derived Parameters
Enable the display of thickness or resistivity in the Results box and completed wafer maps via the
controls in this dialog.
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If either thickness or resistivity of a film is known, the other can bemeasured by the R50 by selecting the
appropriate radio button and entering the known value. Thickness units available are μm, nm, and Å.

These controls are split into Constant and Variable resistivity sections. Constant assumes the values for
thickness or resistivity are the same at all locations measured, while Variable allows for changes across
the surface using the equation Thickness = C*Rs^EXP. It is assumed that the end user knows the
constant (C) and exponential (EXP) values to be entered for this equation.
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3. Making Measurements
Accuratemeasurements with the R50 rely on using the proper measurement setup. The basic steps for
any R50measurement are:

1) Selecting and/or editing the Recipe to bemeasured.
2) Loading the sample.
3) Clicking on theMeasure button to acquire and analyze the data.

The examples below further explain this sequence of steps. In each example, it is assumed that the
hardware has been set up as described in theQuick Start Guideand that the user has read theSoftware
Overview section and is familiar with the basic controls.

3.1 Probe Head Selection

Many users use the same probe head to measure a variety of wafers. This practice can produce
erroneous readings or cause electrically-noisy measurements. The table below describes the probe heads
typically used by application.

Probe
Type

Part
Number

Description (radius, load-
ing, material, spacing)

Application

A
4PP-
TypeA

1.6mil, 100 gm, Tungsten
Carbide, 40mil (1mm)

For measuring metals
F

4PP-
TypeF

1.6mil, 100 gm, Tungsten
Carbide, 25mil (0.6mm)

B
4PP-
TypeB

4.0mil, 100 gm, Tungsten
Carbide, 40mil (1mm) General purpose head for implantation, doped poly, sili-

cides, epitaxy, and diffusion
G

4PP-
TypeG

4.0mil, 100 gm, Tungsten
Carbide, 25mil (0.6mm)

C
4PP-
TypeC

8.0mil, 100 gm, Tungsten
Carbide, 40mil (1mm) Specifically designed for high impedance surfaces such as

low implant dose, shallow junctions, doped poly
H

4PP-
TypeH

8.0mil, 100 gm, Tungsten
Carbide, 25mil (0.6mm)

D
4PP-
TypeD

20.0mil, 100 gm, Tungsten
Carbide, 40mil (1mm) For very difficult implant and high impedance surfaces bey-

ond 8.0mil
I

4PP-
TypeI

20.0mil, 100 gm, Tungsten
Carbide, 25mil (0.6mm)

E
4PP-
TypeE

1.6mil, 200 gm, Tungsten
Carbide, 62.5mil (1.6mm)

Probe head specific to substratemeasurements; i.e bulk
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Remember to use different probes to measuremetal films and silicon wafers. For example, aluminum is a
soft metal and oxidizes easily. As the probe repeatedly contacts an aluminum film, some of the
aluminum collects on the probe tips. This excess aluminum can smooth over and insulate the surface of
the probe tips. If you were to use this probe tomeasure a highly polished and oxidized (native oxide)
silicon wafer, there would be very little penetration or electrical contact by the probe tips as illustrated
below.

For more information on how probes wear, see the ProbeMonitoring section in the appendices.

3.2 Example A: Measuring Sheet Resistance Using the Four Point
Probe

Measuring Sheet Resistance of a Ti film.
In this example wewill cover the basics ofmaking a four point probemeasurement of a Ti film on the
R50-4PP. While this application is specific to Ti films, the basics covered can be applied to most any
material that can bemeasured on the R50-4PP.

It is assumed that theGo To Z Measure height has already been calibrated before starting the
measurement. If this hasn't been completed, see Calibrate Z-Height Measure for details.

Continue to step 1.

Example A: Preparing for Measurement.
Before taking a measurement, a basic recipemust be configured.

First, click on Edit Recipe and select the Rs Acquisition Settings tab.
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Select Auto Range under Current Selection with a Starting Current of 1mA and a Target Voltage of 7.5
mV. This method is slower than the Fixed or Optimize Current options, but is best used when optimal
values are not yet known. See Current Selection for more details on modifying these values for other
applications.

Next, click the drop-down menu next to TCR library and select the Ti correction file. Enter the current
room temperature into Correct to Temp (oC).

This example will not include a map, so Auto Re-probe should be left disabled.

This example assumes an R50-4PP, so theMethod should be preselected to 4PP. Select theDual 4PP
Mode from the drop-down list. When all values have been updated, click OK to apply the changes and
close the dialog.

Continue to Step 2.

Example A: Making the Measurement.
Click theGo To button to open the stagemotion control dialog. Click Go To Unload to move the stage to
the unload position. Place the sample on the stage, then click Go To Load to move the stage to the (0,0)
point. Click OK to exit the dialog.

With the sample in position under the head, click theGo To Z Measure button to move the
measurement head into position. Once the head is in position, clickMeasure to take a single point
measurement. The head will drop down to the sample and take a measurement, and then lift back up off
the sample. Results are displayed in the Results window, including additional parameters enabled via
Edit Derived Parameters.



37

See Editing Film Recipes > Wafer Map Tab for more details on configuring themap settings to run a
map of the sample surface. Additionally, faster measurements can be completed by changing to a fixed
current in the recipe using the calculated current shown in the Results window.

3.3 Configuring Current

Selecting the proper current is imperative to get high quality measurements on the R50. The following
guide covers how to best set current through the Acquisition Settings section of the recipe.

To configure themeasurement parameters, select a target voltage or a fixed current. When Auto Range
under Current Selection is selected, the value in the Target Voltage text box is usually set at 7.5mV
(directing the system to search until it finds a current that results in a measured voltage of 7.5mV). The
system then uses this current to measure wafers.

The optimum current is achieved by testing the sample by using various currents:

l If sheet resistance remains constant, the highest current usually gives themost consistent results.
l If sheet resistance decreases at higher currents, the probable cause is substrate leakage. The cur-

rent should be reduced.
l If sheet resistance increases at higher currents, and the layer has a positive temperature coef-

ficient of resistance, the probable cause is local heating. The current should be reduced.

Occasionally, a high resistance layer requires only very small current to meet the default voltage
requirements. Additionally, if the substrate resistivity is very low, the potential for substrate leakagemay
be high. Under these circumstances, the leakage current may be an appreciable proportion of the
measurement current, and the apparent sheet resistance will be low. Therefore, the highest substrate
resistivity that can be practicably obtained should be used in conjunction with the lowest reasonable
current.

Theminimum noise is usually achieved with a trial-and-error method: several measurements are taken at
a Fixed Test Current, and the standard deviation is noted. The current is then increased, the
measurements are taken again, and the standard deviation at the new current is noted. This process is
repeated at several different currents until the current producing theminimum standard deviation is
determined. (The current should, of course fall within the acceptable current range as determined
above.) This process should be employed when trying to measure a problem wafer which you have been
unable to measure successfully or when a problem occurs with a known measurement process.

3.4 Troubleshooting

Most errors encounter on the R50 tools can be solved using by power cycling the system. See the
document below for step-by-step instructions.

Power Cycling
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Power Cycling
Over the years, we've found that about a third of support issues can be resolved with a simple power
cycle of the Filmetrics system and computer. Follow the steps below to power cycle your instrument.
Further assistancemay be received by contacting us. See the Contact Information section.

Step 1: Shut down RsMapper (if unable to shut down, continue to Step 2).

Step 2: Turn off power at the back of the system.
Note: If the system is being powered down without a proper software shutdown, support the probe lift mechanism
manually to allow for a controlled drop.

Step 3:Unplug all electrical connectors from the back of your Filmetrics system.

Step 4: Restart the computer, allowing time for all drivers to load.

Step 5: Reconnect the electrical connections to your Filmetrics system. Ensure the power cord is
getting power, and that any switches near the power connector are turned on.

Step 6: Restart RsMapper.

3.4.1 Software Reinstallation Guide
Follow the steps below to reinstall RsMapper. Contact Filmetrics for further assistance. See Contact
Information section.Warning: Upgrading software versions may result in slightly different (<1%)
measurement results due to continual improvement of our solving algorithms and material files.

Step 1: Shut down RsMapper (If unable to shut down, continue to Step 2).

Step 2: Turn off power at the back of the system.

Step 3: Unplug all electrical connectors from the back of your Filmetrics system.

Step 4: Are you installing this software on a computer which already has RsMapper installed?
Yes: Go to Step 5.
Yes: Jump to Step 7.

Step 5:Make a backup copy of your recipe and material files:
On Windows 7/8/10: Backup the directory C:\Program Data\Filmetrics\
Note: The Program Data folder may be hidden by default.

Step 6: Uninstall the current version of software:
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On Windows 7/Vista: Click the Start orb > Control Panel > Programs and Features > RsMapper >
Uninstall
On Windows 8: Control Panel >More settings > Programs and Features > RsMapper > Uninstall
On Windows 10: Control Panel > Programs and Features > RsMapper > Uninstall

Step 7: Run the software installer and follow installer instructions.
Note: you will need administrative privileges to install the software.

Step 8: Reconnect your Filmetrics system.
Note for Windows 7/8/10: An Information balloon may appear over the taskbar while drivers are
being installed. Please wait until the balloon indicates the drivers have been installed before
starting RsMapper.

Step 9: Run the software to verify the installation was successful.

Verifying Tester Electronics
This procedure employs resistor networks (also called resistor packs) to help confirm that tester
electronics are functioning properly. The resistor packs are installed in place of the probe head. Using
resistor packs ensures that measurements are not influenced by probe contact problems or by probe
arm mechanical movement. Use the set of resistor packs that shipped with the system.

WARNING

ELECTRIC SHOCK HAZARD: Type 3 - Equipment is energized and live circuits of less than 30 Vrms, 240 VA,
or 20 joules are exposed to accidental contact.

Any work done on areas using 24 VDC or 24 VAC, if the power is left on, qualifies as a Type 3 task.
• The 24 VDC areas include

– The interlock logic PCA
– The theta interconnect PCA
– The probe up sensor PCA
– The Radial sensor PCA

Verifying the electronics:
1. Remove the probe head from the probe arm as described in Changing 4-Point Probes.
2. Insert the resistor pack.
3. Load the appropriate RPAC recipe.
4. Go to theMap tab.
5. Click Start.
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Themeasured values shown should agree within the tolerances given on the resistor pack. If the
measure value falls outside of the specified tolerance for a given current range, please contact Filmetrics.
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4. Advanced Features
This section describes use of themap pattern generator and how to edit map files within Microsoft Excel.

Using the Map Pattern Generator

Editing Map Files Using Excel

4.1 Creating New Map Patterns

The Edit Map Pattern tool is best used for simpler maps on blanket wafers. To create a newwafer map
pattern, go to theWafer Map Tab and select Edit > Map Pattern…Once selected, a newwindow
appears which allows parameters to be adjusted to create a custom wafer map.
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1. Select the Round or Squarewafer shape.

2. Select how themeasurement points are distributed on the sample. The alignment can be Radial
(Polar), Rectangular, or Linear.

3. Control themeasurement point density. The # of Spots from Center to Outer Edge specifies how
many points are placed in a line between the center and the edge. The Central Exclusion specifies how
much of the center (if any) should be excluded from measurement.

4. Select howmany spots are in each quarter section of the ring (when the Radial pattern type is
selected). WhenManual Spots per Quadrant is not selected, Ring 1 is automatically set to 1, and Each
additional ring is automatically set to 2.
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5. Select whether themeasurement points should span the Center to Edge, or the Edge to Edge (only
available when the Linear pattern type is selected).

6. Use Redraw to refresh the wafer map based on the current settings to verify themap is correct.

7. Save the wafer map to a file for subsequent use in a Recipe.

An Existing Pattern can also be opened for editing, or Import one that has been created using Excel.

4.2 Editing Map Files Using Excel

Map files can be further edited using Microsoft Excel in order to createmore complex patterns. The .pat
file created by RsMapper can be imported into Excel for editing and saved as a comma-delimited file
(.csv). The newly edited file can then used in RsMapper to createmore intricatemap patterns. The
example below shows how to create an “X” pattern starting with the default pattern.

Example: Creating an “X” map pattern starting with the default map pattern

Step 1: Create a new map file
In themap window, go to Edit > Map Pattern…Using a Roundwafer type and a Radial pattern
type, select 3 for # Spots from center to Outer Edge. SelectManual Spots per Quadrant and use 2
for Ring 1 and Each additional ring.

Save this default map pattern as Custom.

Step 2: Import the map pattern into Excel
Using Excel, open the file Custom.pat. This file can be found in C:\Program
Files\RsMapper\Patterns\Custom\. (Note: If the file does not appear in theOpen dialog box,
choose All Files (*.*) under File Type.)

When prompted to import this file, select Delimited, click Next, then select Comma for the
Delimiters.

Step 3: Edit map pattern in Excel
Starting in the fourth row, values are stored as x-y coordinate values, as a fraction of the radius of
the wafer. When generating newmaps, values can be entered as either a fraction of the radius of
the wafer, or a discrete number, as long as all values are to the same scale. To create the “X”
pattern, delete the highlighted rows shown in Figure below so that there are no empty rows
between values. Delete the first two rows by selecting rows 1 and 2 and selecting Delete from the
Editmenu.



44

Delete the highlighted cells to leave the desired coordinates.

Step 4: Save map pattern
After themodifications have been made, select File > Save. Check that the File Name box is
“CustomEdit.pat” (note: quotation marks must be used to enclose the filename in Excel to force the
extension to .pat) and that the File Type is CSV (Comma delimited) (*.csv). Click Save.

Step 5: Import the Map Pattern
In RsMapper, select Edit >Map Pattern.... Enable the radio button for File-Imported Pattern, and
then switch to the Imported Pattern tab and click Open.... The following dialog will open:
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Increase theOptions > Line to skip value until the first value visible in the list is the first coordinate
in the series. TheWafer Diameter/Width and Height is also set here according to the values used
for the coordinate scale. If fractional values are used, set theWafer Diameter/Width, and Height for
rectangular samples, to 2 (-1 to 1). If whole values are used, enter the sample dimensions. Click OK
when finished.

Step 6: Save the Pattern File
The new pattern file is displayed in the Edit Map Patternwindow. Confirm it matches the expected
pattern and save the new pattern using the Save As button.

Note: If the wafer map does not show up as described, open the file C:\Program
Files\RsMapper\Patterns\custom\Custom.pat using a text editor, such as Microsoft Notepad.
Check to see that the first row does not contain a comma. If it does, delete the comma and save the
file.



46

Figure: “X” pattern created using Excel.

Step 7: Load map pattern in RsMapper
In RsMapper, click the Edit... button next to the Recipe pull-down menu on theWafer Map tab, or
Edit Recipe if you are in theMeasure tab. Click theWafer Map tab in the recipe window and select
Custom for the Coordinate System. All customemap file names will be listed under Custom Name.
Here, select Custom Edit, and then click OK. In theWafer Map Tab, you should now see the “X”
pattern you created. RsMapper is capable of automatically resizing themap pattern after it has
originally been created, so there is no need to createmultiple versions of the same file. Simply
adjust the wafer size in the recipe.
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5. Theory of Operation
Resistivity, ρ, is a measure of the inability of a film to support the conduction of electrical carriers. In a
metal layer, these carriers are electrons. For semiconductor layers, these carriers can be electrons (n-type
material) or holes (p-typematerial). Resistivity, whose units are ohm-centimeters (Ω-cm), is a bulk
property of thematerial. It is a function of the carrier concentration, n, and the carrier mobility, μ, as
expressed in the equation.

where e is the electronic charge.

When characterizing thin films, it is useful to introduce the concept of resistance per unit area, or sheet
resistance. The sheet resistance Rs of a homogeneous layer is defined as

where t is the thickness of the layer. For example, a 2-micron thick epitaxial layer for which ρ = 0.1 Ω-cm
has a sheet resistance of Rs = 0.1 Ω-cm / 2 x 10-4 cm, or 500 Ω/sq.

Resistance, R, is defined as

where the cross-sectional area A = t · w
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Measuring the Resistance of a Rectangular Bar

Using Ohm’s Law (V = IR), we can write resistance as

and substituting for ρ, we get

therefore
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Thus, a rectangular bar for which Rs = 100 Ω/sq., l = 100mm and w = 10mm, has a resistance (R) of 1000
Ω.

In most semiconductor applications, the carrier concentration, and therefore the resistivity, varies as a
function of the depth z below the surface of the layer; that is,

where themobility μ is also a function of the carrier concentration n

Carrier Concentration as a Function of Junction Depth

Thus, themeasured sheet resistance is a weighted average given by the equation
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where the integration is performed over the full thickness of the film. For the case of a p-n junction
isolated layer, the thickness t is equal to the junction depth zj.

The sheet resistance of the conducting layers employed in semiconductor processing varies over a range
of about 0.02 Ω/sq. (as with aluminum) to 1,000,000 Ω/sq (as with threshold adjust implants in MOS
applications).

Sheet resistancemeasurements are routinely employed in semiconductor manufacturing facilities
because of the accuracy, repeatability, and relatively low cost of themeasurement equipment. In the
case of semiconductor layers, they are frequently supplemented by various depth profiling techniques
such as Secondary Ion Mass Spectroscopy (SIMS), spreading resistancemeasurements on beveled
samples, and, for lightly doped layers, capacitance voltage techniques.

5.1 R50-4PP Hardware Operation

The four-point probe is commonly used to measure the resistivity of large-volume samples, such as
ingots and wafers, and the sheet resistance of thin layers, such as epitaxial silicon and sheet diffusions.
The resistivity and surface preparation of thematerial are important determinants of the accuracy of the
measurements that can bemadewith the four-point probe. As discussed below, sample geometry must
also be taken into account to ensure accurate readings.

Probe-tip spacings typically range from 0.025 inches to 0.062 inches. Precision four-point probe
assemblies employ ruby guides and individually adjusted springs for each probe tip. Probe force, tip
radius, and probematerial must be selected with consideration for the resistivity, hardness,
and thickness of the layer to bemeasured.

The sheet resistance Rs is obtained by introducing a current I through two pins and determining the
voltage drop V across the two remaining pins. For the linear array, it is customary for the outer two pins
to carry current and the inner two pins to measure the resulting voltage.
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If the probe-tip spacing is equal (S1=S2=S3) and the sample area is large compared to the probe tip
spacing,

where Ra = Va/I.

NOTE: R and Ra represent the average of the two resistance values obtained by reversing the polarity of the current supply.

Geometric Effects in Four-Point Probe Measurements
As in the case ofmicroelectronic resistor structures, four-point probe sheet resistancemeasurements are
susceptible to geometric errors. Accuratemeasurements require compensation both for variable probe-
tip spacing
and the influence of non-conducting wafer boundaries. If these effects are known, the sheet resistance is

where B is a correction factor (Cf) that takes into account geometric effects.
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Self-Compensation for Geometric Effects Using Paired ResistanceMeasurements
Sheet resistancemapping of highly uniform layers, such as those obtained by ion implantation, requires
a greater accuracy and measurement repeatability than can be achieved using the conventional
measurement technique and the correction procedures previously discussed.

Fortunately, for the case of the linear array there exists a self-compensation technique (called dual
configuration) for eliminating geometric sources of error, analogous to that used with van der Pauw
sheet resistors. The standard (traditional) technique requires the four pins to be parallel to the radius of a
circular wafer (β = 0). The enhanced technique is valid if the probe tip array is perpendicular (β = π/2) to
the radius as long as r - ro > 1S, where B is the average probe tip spacing.

Two resistances aremeasured using one of these techniques. The first resistance, Ra, is obtained in the
conventional manner with the outer pins carrying current while the inner pins measure the resulting
voltage drop. The second value, Rb, is obtained by passing current between the first and third pins and
measuring voltage across the second and fourth pins. Then, the sheet resistance is calculated as

where kξ and jξ , the geometric correction factors for the standard and enhanced techniques
respectively, depend only on the ratio ξ = Ra/Rb

For the ideal case of equal probe tip spacing (S1=S2=S3) on an infinite sheet (r =∞),

Using paired-resistancemeasurements, one can achieve a measurement accuracy of about 0.5% and a 1σ
repeatability of 0.1–0.2%.
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6. Appendices
This section contains information on various topics as listed below:

Probe Monitoring

How to Replace a Four-Point Probe

Performance Specifications

Software License Agreement
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How to Contact Us
For further support, or to report any EHS issues related to the equipment please use the contact details
below.

Reach us by phone at +1-858-573-9300, by fax at +1-858-573-9400, by the Contact Us Now form on our
website, or by e-mail at support@filmetrics.com.

6.1 Probe Monitoring

As the 4-point probe is used, a certain amount of wear is expected to occur as a result of the repeated
collision with the sample surface. The following section provides description of this wear and how it
affects measurement, how to track it, and what can be done to maintain the probes.

Contact Resistance and Probe Tip Diameter
Short-Term System Repeatability and the Effects of the Probe Head
Probe Conditioning

Contact Resistance and Probe Tip Diameter
Since each probe is not a single contact point but has multiple contact points due to the rough surface of
the tungsten carbide, there aremultiple resistances all in parallel. The effective resistance is a function of
the resistance of all the contact points. You can decrease the effective resistance by increasing the
number of contact points. This is done by increasing the area of contact (i.e., the tip radius). The figure
below shows the different probe tip types and their diameters.

http://filmetrics.com/forms/generic
http://filmetrics.com/forms/generic
mailto:support@filmetrics.com?subject=Tech Support Request?subject=Tech Support Request
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A sharp probe, such as a 1.6-mil radius tip, works very well for metal layers where contact resistance and
probe penetration are not a problem. Silicon wafers and wafers with implanted layers can have high
contact resistance. For high dose implants (> 1E14 ions/cm2) or low-resistivity silicon (lower than 10 -cm),
a 4-mil radius tip is recommended. For medium-dose implants (1E14 – 1E13 ions/cm2) and medium-
resistivity substrates (1–100 Ω-cm), an 8-mil tip is more appropriate. For low-dose implants(< 1E13
ions/cm2) or high resistivity materials (> 100 Ω-cm), a 20-mil probe tip will probably work best.

When trying to measure a sawed or lapped surface, measurement problems are often experienced
because this is a non-continuous surface and will reduce the number of contact points. In this case a
higher probe loading or spring pressure is needed to make a positive contact to the surface. An increase
to 200-gm loading from the usual 100-gm will usually solve contact problems on rough surfaces. Some
bare silicon wafers may have a depletion region caused by the polishing process and may require a 10-
minute bake at 200 oC on a hot plate, to replenish the surface, or a 1.6-mil, 200-gm probe to penetrate
the layer. The table below shows a chart of preferred probe-tip radii for different wafers.

Probe Conditioning
Over a period of time, material collects on the probe tips and they will also wear down from repeated
contact with sample surfaces. These factors prevent the probe from making good contact with the wafer
leading to poor repeatability and measurement errors. The Probe Conditioningmethod employs a
ceramic plate to remove these particles and roughen the surface of the probe tip to restore stable
measurements.

Note: Probe Conditioning should only be performed when necessary. Routinely conditioning the probe at the beginning of every
shift could lead to premature probe failure. Typically, condition a probe only if a Qualification (Qual) Procedure shows poor
repeatability or measurement errors.

Qualifying the Probe
To qualify the probe for conditioning:

1. Place a known sample on the stage.
2. Select the appropriate Recipe.
3. Use theGo To command to move the sample under the probe.
4. Press Probe Down to bring the probe in contact with the sample.
5. Enable Skip motor motions.
6. ClickMeasure.
7. The standard deviation of themeasurements determines the number of repetitions required

when conditioning the probe.

Conditioning the Probe
1. Place the ceramic plate (CondWafer-4PP, P/N:200-0639) onto the center of the stage.
2. Use theGo To command to move the wafer under the probe.
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3. Enter the desired number of repetitions in the Repeats box.
1. The number of repetitions depends on the monitor wafer and probe head types. Use the results of

the qualifying test and the recommendations in the table below as general guidelines. Increase as
required.

Standard Deviation (%) Repetitions

0.2% to 0.5% 25

0.5% to 1% 75

> 1% 150

4. Click Start…
5. Perform two more probe qualifications.

The standard deviation values from the second test should be within specification. If the values are out
of the specification, repeat the conditioning procedure until the results do not improve from at least two
consecutive loops.
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If repeated conditioning cycles do not improve the standard deviation results, contact Filmetrics for
further corrective action.

6.2 Changing Four-Point Probes

The following steps can be followed to switch between different four-point probe heads as required. We
recommend removing any samples from the stage prior to changing out the probe.

1. Click the Probe Change button to position the system head. Note that while the Probe Change button
is selected, all other motion controls are disabled.

2. Pull open the locking lever on the probe assembly.

3. Lift the probe straight up out of the assembly. Note that twisting or turning the probe while removing
it may damage the 6-pin connector.

4. Place the probe in the Filmetrics provided storage case for safe keeping.

5. Place the new probe into the probe assembly, being careful to align the 6-pin connector.

6. Push down gently on the top of the probe until set in place.

7. Close the locking lever on the assembly.

8. Click the Probe Change button.

6.3 Performance Specifications

General Electrical Performance 4PP
Z Range: 100 mm Site Repeatability <0.2%
Z Stage Type Automated Accuracy +/- 1%
X-Y Stage Type Automated Measurement Range1 5mOhm/sq - 5MOhm/sq
Sample Max Weight 2.5kg Matching1 <0.2%
Tip-Tilt Stage +/- 5o, Manual

Mechanical Performance Electrical Performance EC
X-Y Stage Range 100mm x 100mm Site Repeatibility <0.2%

Sample Max Width 265mm Accuracy +/- 1%
System Size, W x D x H 305mm x 305mm x 550mm Measurement Range1 1mOhm/sq - 10MOhm/sq

System Weight 15kg Matching1 <0.2%

X-Y Stage Range 200mm x 200mm

Sample Max Width 365mm
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Mechanical Performance Electrical Performance EC
System Size, W x D x H 406mm x 406mm x 550mm

System Weight 22kg

4PP (four-point probe)
Probes Type A Type C Type E Type F

Probe Spacing 1mm 1mm 1.625mm 0.625mm
Probe Contact Radius 40µm 200µm 40µm 40µm

1 Typical value

6.4 End User Software License

Important – Read carefully: This Agreement (“Agreement”) is a legal agreement between you (both you,
individually and your company entity) and KLA Corporation. (“Licensor” or “KLA”) The RsMapper
software (the “Software”) subject to this Agreement and any accompanying documentation is for your
use solely and exclusively with an authorized device manufactured by or for KLA (“KLA Device”).

By downloading, installing, copying or otherwise using the Software you
expressly agree to be bound by all of the terms of this Agreement. This Agreement is
displayed for you to read prior to using the Software. If you choose not to accept, or do not agree with all
of the provisions of this Agreement, do not download, install or use the Software but, instead delete it
and, if applicable, request from the authorized KLA distributor from whom you purchased the Software
license, a full refund of any fees you paid for the Software license.

LICENSE
This license agreement (“license”) permits you to use one copy of the Software on any single computer.
The Software is owned by KLA and is protected by United States copyright law and international treaty
provisions. Therefore, this software should be treated as any other copyrighted material except that you
may either: (1) make one copy of the Software for archival backup purposes, or (2) copy the Software to a
single hard disk in all cases, solely for use with a KLA Device. If the Software is used on a networked
computer system wheremore than one computer can access the Software provisions must bemade to
insure that the number of concurrently executing copies of the Software cannot exceed the number of
licenses.

You may transfer the Software and all rights under this Agreement to another party together with a copy
of this Agreement if the other party agrees to accept the terms and conditions of this Agreement. If you
transfer the Software, you must at the same time either transfer all copies (including any prior versions)
in any form to the same party or destroy any copies not transferred.
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RESTRICTIONS
You may not use, disclose, distribute, copy, modify, rent, lease, loan, resell, network or transfer the
Software, or any copy, modification or merged portion thereof, in whole or in part, to any third party
except as expressly specified in this Agreement. You agree to provide reasonable security precautions to
prevent unauthorized access to or use of the Software as proscribed herein. You agree not to decompile,
reverse engineer, disassemble or otherwise reduce the Software to a human perceivable form and you
agree not to permit any person or entity to do so. You shall not remove, alter, cover, or obscure any
confidentiality, trade secret, proprietary, or copyright notices, trademarks, proprietary, patent, or other
identifying marks or designs from any component of the Software, and you shall reproduce and include
in all copies of the Software the copyright notice(s) and proprietary legend(s) of KLA and its licensors as
they appear in the Software.

SOURCE CODE
If source code to the Software was supplied to you, then you may modify and use that source code in
place of the executable version of the Software, but no further rights to distribution or use are granted.
You acknowledge that you have no obligation to createmodifications of the Software source code
(“Licensed Revisions”) nor to disclose such Licensed Revisions to Licensor. You acknowledge that by
making Licensed Revisions, the underlying Softwaremay not be compatible with any future versions of
the Software that Licensor might offer (in Licensor’s sole discretion), and you agree to assume such risk.
Continuing for the term of this Agreement, you hereby grant to Licensor and its affiliates a limited non-
transferable, non-exclusive, worldwide, fully paid-up, royalty-free license (with the right to sublicense) to
make, use, sell, offer to sell, import, export and otherwise distribute such Licensed Revisions under any
of your patents that, if not authorized, would be directly or indirectly infringed by themanufacture, use,
sale, offer to sell or other distribution of the Licensed Revisions. You may not combine or distribute the
Software or Licensed Revisions with Open Source Software (as defined below) or with software developed
using Open Source Software (e.g., tools) in a manner that subjects the Software and Licensed Revisions
or any portion thereof to any license obligations of such Open Source Software. "Open Source Software"
means any software licensed under terms requiring that other software combined or distributed with
such software: (i) be disclosed or distributed in source code form; (ii) be licensed on terms inconsistent
with the terms of this Agreement.

TERM
This Agreement is effective until terminated. You may terminate it at any time by destroying the Software
together with all copies, modifications and merged portions in any form. This Agreement will
immediately and automatically terminate without notice if you fail to comply with any term or condition
of this Agreement. You agree upon termination to cease using and promptly destroy the Software and
Licensed Revisions together with all copies in any form.

GOVERNMENT LICENSEE
If you are acquiring the Software on behalf of any unit or agency of the United States Government, the
following provisions apply:



60

The Government acknowledges the licensor’s representation that the Software and its documentation
were developed at private expense and no part of them is in the public domain. The Software is a
"commercial item," as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of "commercial
computer software" and "commercial computer software documentation," as such terms are used in 48
C.F.R. 12.212 (SEPT 1995). All U.S. Government licensees and end users acquire the Software with only
those rights set forth herein.

EXPORT LAW ASSURANCES
You acknowledge and agree that the Software is subject to restrictions and controls imposed by the
United States Export Administration Act (the “Act”) and the regulations thereunder. You agree and certify
that neither the Software nor any direct product thereof is being or will be acquired, shipped, transferred
or re-exported, directly or indirectly, into any country prohibited by the Act and the regulations
thereunder or will be used for any purpose prohibited by the same.

DISCLAIMER OF WARRANTIES. EXCEPT TO THE EXTENT OF ANY LIMITEDWARRANTY PROVIDED BY THE
SELLER, THE SOFTWARE IS FURNISHED "AS-IS", AND TO THEMAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, LICENSORMAKES NOWARRANTY, EXPRESS, IMPLIED OR STATUTORY, INCLUDING ANY
IMPLIEDWARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, TITLE OR NON-
INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE SECRETS OR OTHER INTELLECTUAL
PROPERTY RIGHTS. LICENSOR DOES NOTWARRANT THAT THE SOFTWARE IS FREE FROM BUGS, VIRUSES,
ERRORS OR OTHER PROGRAM LIMITATIONS. YOU AGREE TO USE YOUR INDEPENDENT JUDGMENT IN
DEVELOPING YOUR PRODUCTS. YOU ACKNOWLEDGE AND AGREE THAT LICENSOR IS UNDER NO
OBLIGATION TO INSTALL, MAINTAINOR SUPPORT THE SOFTWARE, OR PROVIDE UPGRADES OR NEW
RELEASES THEREOF, SHOULD LICENSOR PROVIDE ANY ASSISTANCE LICENSORMAKES NOWARRANTIES
WITH RESPECT TO ANY SUCH ASSISTANCE. YOU ASSUME THE ENTIRE RISK ARISING OUT OF THE USE OR
PERFORMANCE OF THE SOFTWARE AND ANY SYSTEMS OR PRODUCTS YOUDESIGNUSING THE
SOFTWARE.
EXCLUSION OF DAMAGES. TO THEMAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL
LICENSOR, OR ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, AFFILIATES OR ANY APPLICABLE
LICENSOR (TOGETHER THE “REPRESENTATIVES”), BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL,
PUNITIVE OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO, DAMAGES FOR ANY LOSS OF
USE, LOSS OF TIME, INCONVENIENCE, COMMERCIAL LOSS OR LOST PROFITS, SAVINGS OR REVENUES,
HOWEVER CAUSED, ONANY THEORY OF LIABILITY, IN CONNECTIONWITH OR ARISING OUT OF THIS
AGREEMENT, THE SOFTWARE, THE LICENSED REVISIONS EVEN IF LICENSOR REPRESENTATIVES HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND EVEN IF A REMEDY SET FORTH HEREIN IS FOUND
TO HAVE FAILED OF ITS ESSENTIAL PURPOSE. IN NO EVENT SHALL LICENSOR’S AGGREGATE LIABILITY
UNDER THIS AGREEMENT EXCEED USD $500.00 OR THE FEES PAID BY YOU FOR THE SOFTWARE UNDER
THIS AGREEMENT. THE LIMITATIONS OF DAMAGES SET FORTH ABOVE ARE FUNDAMENTAL ELEMENTS OF
THE BASIS OF THE BARGAIN BETWEEN LICENSOR AND YOU.
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GENERAL
This Agreement will be governed by the laws of the State of California, U.S.A. without regard to its conflict
of law provisions. If a court of competent jurisdiction finds any provision of the Agreement to be
unenforceable, that provision will be enforced to themaximum extent possible to effectuate the intent of
the parties, and the remainder of the Agreement will continue in full force and effect. Failure of Licensor
to enforce any terms of this Agreement shall not be deemed or considered a waiver of future
enforcement of that or any other term in this Agreement and no consent, waiver, or excuse by Licensor,
express or implied, constitutes a subsequent consent, waiver or excuse. You acknowledge that you have
read this Agreement, understand it and agree to be bound by its terms and conditions. You further agree
that it is the complete and exclusive statement of the agreement between us which supersedes any
proposal or prior agreement, oral or written, and any other communications between us in relation to
the subject matter of this Agreement. This Agreement shall bemodified only by a written instrument
signed by a duly authorized representative of Licensor, or from time to time, Licensor may modify or
change the terms and conditions of this Agreement and supersede the terms of any prior version of this
Agreement, in connection with any supplemental, different or new terms that might apply to an update
or upgrade of the Softwaremade available by Licensor, in Licensor’s sole discretion. Your continued use
of the Software after you download and accept the new, additional or changed terms applicable to such
update or upgrade will indicate your agreement to the change to this Agreement. You may not sell,
assign, transfer, delegate, convey, pledge, encumber or otherwise dispose of, by operation of law or
otherwise, the Software, Licensed Revisions or this Agreement, or any rights or obligations hereunder.
Licensor may assign this Agreement, and any or all of its rights and duties under this Agreement, without
prior notice to you or your consent. You hereby warrant and represent that you have obtained all
authorization and other applicable consents required empowering you to enter into this Agreement.
Rights and obligations under this Agreement which by their nature should survive, will remain in effect
after termination or expiration of this Agreement.
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